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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description HP EliteBook 8470w
Mobile Workstation

computer model

HP EliteBook 8470p
Notebook PC

computer model

Product Name HP EliteBook 8470w Mobile Workstation
computer model

√  

 HP ProBook 8470p Notebook PC
computer model

 √

Processors ● Intel® Quad Core® i7-3820QM 2.70-
GHz processor (SC turbo up to 3.70-
GHz; 1600-MHz FSB, 8.0-MB L3
cache, 45 W)

√  

 ● Intel Quad Core i7-3720QM 2.60-
GHz processor (SC turbo up to 3.60-
GHz; 1600- MHz FSB, 6.0-MB
L3 cache, 45 W)

● Intel Quad Core i7-3610QM 2.30-
GHz processor (SC turbo up to 3.30-
GHz; 1600- MHz FSB, 6.0-MB
L3 cache, 45 W)

● Intel Dual Core i7-3520M 2.90-GHz
processor (SC turbo up to 3.60-GHz;
1600-MHz FSB, 4.0-MB L3 cache,
35 W)

● Intel Dual Core i5-3360M 2.80-GHz
processor (SC turbo up to 3.50-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

● Intel Dual Core i5-3320M 2.60-GHz
processor (SC turbo up to 3.30-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

computer model

HP EliteBook 8470p
Notebook PC

computer model

 ● Intel Dual Core i5-3210M 2.50-GHz
processor (SC turbo up to 3.10-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

● Intel Core i3-3110M 2.40-GHz
processor (1600-MHz FSB, 3.0-MB
L3 cache, 35 W)

 √

Chipset Mobile Intel QM77 chipset √ √

Graphics Switchable discrete graphics: AMD
FirePro™ M2000 (64-bit), with 1024-MB
GDDR5 (64-MB × 32,1.5V, 5-GBPS,
quantity 4); supports open GL

√  

 Switchable discrete graphics: AMD
Radeon™ HD 7570M (64-bit), with 1024-
MB GDDR5 (64-MB × 32,1.5V, 5-GBPS,
quantity 4)

Internal graphics:

● Universal memory architecture (UMA)
with shared video memory

● Intel HD Graphics 4000

 √

 ● Support for dual-display ports through
docking station

● Support for DisplayPort 1.2 (only on
computer models equipped with a
graphics subsystem with
discrete memory)

● Support for up to 4 displays through
the APR (only on computer models
equipped with a graphics subsystem
with discrete memory)

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

computer model

HP EliteBook 8470p
Notebook PC

computer model

Panel ● 14.0-in light-emitting diode (LED), high-
definition+ (HD+), AntiGlare (AG), SVA
(1600×900) display with and without
webcam and microphone

● 14.0-in LED, HD, AG, SVA
(1366×768) display with and without
webcam and microphone

All display assemblies include two wireless
local area network (WLAN) antenna cables
and two wireless wide area network
(WWAN) antenna cables

Supports low voltage differential
signalling (LVDS)

Supports 16:9 aspect ratio

Supports privacy filter

√ √

Memory Two customer-accessible/upgradable
memory module slots

DDR3-1600-MHz dual channel support

Supports 16384-MB of system RAM in the
following configurations:

● 16384-MB (8192-MB×2)

● 8192-MB (8192-MB×1 or 4096×2)

● 8192-MB (8192-MB×1 or 4096×2; not
supported on computer models
equipped with a 32-bit
operating system)

● 6144-MB (4096-MB+2048-MB)

● 4096-MB (4096-MB×1 or 2048-MB×2)

● 2048-MB (2048×1)

√ √

Flash cache Intel 24-GB mSATA module (Intel Smart
Response Technology (SRT), not available on
computer models equipped with WWAN
or SSD)

√ √

3



Category Description HP EliteBook 8470w
Mobile Workstation

computer model

HP EliteBook 8470p
Notebook PC

computer model

Hard drive Supports 6.35-cm (2.5-in) hard drives in 9.5-
mm (.37-in) and 7.0-mm (.28-in) thicknesses
(all hard drives use the same bracket)

Customer-accessible

Serial ATA

Supports the following hard drives:

● 750-GB, 7200-rpm, 9.5-mm

● 500-GB, 7200-rpm, 7.0-mm self-
encrypting drive (SED)

● 500-GB, 7200-rpm, 7.0-mm

● 320-GB, 7200-rpm, 7.0-mm

√ √

Solid-state drive Solid-state drive (SSD) mounts in the same
bracket as the hard drive

Customer-accessible

Serial ATA III

Supports the following SSDs:

● 256-GB SED

● 180-GB

● 160-GB

● 128-GB

√  

Upgrade drive Customer-accessible

Supports the following drive options:

● Blu-ray R/RE DVD±RW SuperMulti
DL Drive

● Blu-ray ROM DVD±RW SuperMulti
DL Drive

● DVD±RW Double-Layer with
SuperMulti Drive

● DVD-ROM Drive

● 500-GB, 7200-rpm, 9.5-mm

Supports no drive option

√  
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Category Description HP EliteBook 8470w
Mobile Workstation

computer model

HP EliteBook 8470p
Notebook PC

computer model

 Customer-accessible

Supports the following drive options:

● Blu-ray ROM DVD±RW SuperMulti
DL Drive

● DVD±RW Double-Layer with
SuperMulti Drive

● DVD-ROM Drive

● 500-GB, 7200-rpm, 9.5-mm

Supports no drive option

 √

Optical drive Fixed

Serial ATA

12.7-mm tray load

Supports the following optical drives:

● Blu-ray R/RE DVD±RW SuperMulti
DL Drive

● Blu-ray ROM DVD±RW SuperMulti
DL Drive

● DVD±RW Double-Layer with
SuperMulti Drive

● DVD-ROM Drive

Supports zero power optical drive

√  

 Fixed

Serial ATA

12.7-mm tray load

Supports the following optical drives:

● Blu-ray ROM DVD±RW SuperMulti
DL Drive

● DVD±RW Double-Layer with
SuperMulti Drive

● DVD-ROM Drive

Supports zero power optical drive

 √

Audio and video Two stereo speakers √ √

 HD audio with SRS Premium Sound PRO √ √
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Category Description HP EliteBook 8470w
Mobile Workstation

computer model

HP EliteBook 8470p
Notebook PC

computer model

 Integrated 720p HD webcam (supports no
camera option)

√ √

 Integrated dual-array microphone on
computer models equipped with a webcam

Integrated mono microphone on computer
models not equipped with a webcam

√ √

Modem 56kbps v.92 MDC data/fax modem module

Supports no modem option

Modem module cable not included

√ √

Ethernet Intel 82579LM 10/100/1000 Ethernet
network interface card (NIC) with
iAMT Intel 82579LM Gigabit
Network Connection

NIC Power Down technology

S3/S4/S5 wake on LAN

Ethernet cable not included

√ √

Wireless Integrated wireless personal area network
(WPAN) option by way of Bluetooth 4.0
enhanced data rate (EDR) module

Supports no WPAN option

√ √

 Integrated wireless local area network
(WLAN) options by way of wireless module

Three WLAN antennas built into
display assembly

Support for the following WLAN formats:

● Atheros WB225 1×1 802.11b/g/n
Bluetooth Combo Adapter

● Broadcom 43228 802.11abgn 2×2
Wi-Fi Adapter

● Intel Centrino Advanced-N 6205
WLAN module

● Intel Centrino Ultimate-N 6300
WLAN module

● Intel Centrino Wireless-N 2200
802.11b/g/n 2×2 WiFi Adapter

Supports no WLAN option

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

computer model

HP EliteBook 8470p
Notebook PC

computer model

 Integrated wireless wide area network
(WWAN) options by way of
wireless module

Two world-wide/5-band WWAN antennas
built into display assembly

Secured by subscriber identity module (SIM,
user-accessible behind battery)

Support for the following WWAN formats:

● HP lt2523 LTE/HSPA+ Mobile
Broadband Module

● HP lt2522 LTE/EV-DO Mobile
Broadband Module

● HP un2430 EV-DO/HSPA Mobile
Broadband Module

● HP hs2350 HSPA+ Mobile
Broadband Module

Supports no WWAN option

Supports WWAN after market option

√ √

External media
cards

Integrated 54-mm ExpressCard

Secure Digital (SD) flash media slot with
push-push technology, supporting the
following digital card formats:

● MultiMediaCard (MMC)

● MMC+

● Secure Digital (SD) Memory Card

● SDHC

● SDXC

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

computer model

HP EliteBook 8470p
Notebook PC

computer model

Ports ● 1394a port

● Audio-in (mono microphone)

● Audio-out (stereo headphone)

● Battery connector

● DisplayPort 1.2 (on computer models
equipped with a graphics subsystem
with discrete memory)

● DisplayPort 1.1a (on computer models
equipped with a graphics subsystem
with UMA memory)

● Docking connector

● eSATA/USB 2.0 combo port

● HP Smart AC adapter

● RJ-45 (Ethernet)

● RJ-11 (modem)

● Secondary battery connector

● Serial port

● USB 3.0 ports (2)

● USB 2.0 port

● USB 2.0 charging port

● VGA (Dsub 15 pin) supporting:
1920×1200 external resolution @
75 Hz, hot plug and unplug and
autodetection for correct output to wide-
aspect vs. standard aspect video

√ √

Keyboard/pointing
devices

Full-size keyboard with numeric keypad
(upper-left justified), dual-point, spill-resistant,
chiclet-style, with durakeys

√ √

 Gesture support: MultiTouch gestures
enabled, two-finger scrolling, and pinch-
zoom as default

√ √

 Taps enabled by default √ √

 Support for TouchPad with image sensor √ √

 Support for Windows 8 Indirect Touch √ √

Power requirements Supports the following HP Smart AC adapters:
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Category Description HP EliteBook 8470w
Mobile Workstation

computer model

HP EliteBook 8470p
Notebook PC

computer model

 ● 90-W HP Smart AC adapter (PFC, EM,
3-wire)

√ √

 ● 90-W HP Smart AC adapter (PFC, 3-
wire)

√ √

 ● 65-W HP Smart AC adapter (non-PFC,
3-wire)

√ √

 ● 65-W HP Smart AC adapter (RC/V,
EM, 3-wire)

√ √

 Supports the following batteries:

● 9-cell, 100-Wh, 3.0-Ah battery

● 9-cell, 73-Wh, 2.2-Ah battery

● 6-cell, 62-Wh, 2.8-Ah battery

● 6-cell, 55-Wh, 2.8-Ah battery

● 3-cell, 31-Wh, 2.8-Ah battery

√ √

Security Supports security cable lock √ √

 Supports fingerprint reader and no
fingerprint reader option

√ √

 Supports Trusted Platform Module (TPM) 1.2
(Infineon, soldered down) and
TPM Enhanced Drive Lock (not supported in
Asia and the People's Republic of China)

√ √

 Integrated Smart Card reader (active) √ √

 Full volume encryption √ √

 Preboot authentication (password,
Smart Card)

√ √

Operating system Preinstalled:

● Windows® 7 Home Premium 64- and
32-bit with Microsoft Basics (in
Canada, Japan, and the United States)

● Windows 7 Professional 64- and 32-bit
with Microsoft Basics (in Canada,
Japan, and the United States)

● FreeDOS

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

computer model

HP EliteBook 8470p
Notebook PC

computer model

 Preinstalled with Microsoft Office:

● Windows 7 Home Basic 32-bit with
Office Starter (emerging markets only,
not available in Japan)

● Windows 7 Home Premium 64- and
32-bit with Office Starter (not available
in Japan)

● Windows 7 Home Premium 64-bit with
Office 2010 Personal (only in Japan)

● Windows 7 Home Premium 64-bit with
Office 2010 Home and Personal (only
in Japan)

● Windows 7 Home Premium 64-bit with
Office 2010 Professional (only
in Japan)

● Windows 7 Professional 64- and 32-bit
with Office 2010 Starter (not available
in Japan)

● Windows 7 Professional 64- and 32-bit
with Office 2010 Business and Home
(only in Japan)

● Windows 7 Professional 64- and 32-bit
with Office 2010 Personal (only
in Japan)

● Windows 7 Professional 64- and 32-bit
with Office 2010 Professional (only
in Japan)

√ √

 Restore media—DR-DVD:

● Windows 7

● Windows 7 with Windows DVD

√ √

 Restore media—OS-DVD:

● Windows 7 Home Basic 32-bit

● Windows 7 Home Premium 64- and
32-bit

● Windows 7 Professional 64- and 32-bit

√ √

 Certified:

● Microsoft WHQL

● SuSE Linux 64-bit Service Pack 2

√ √

10 Chapter 1   Product description



Category Description HP EliteBook 8470w
Mobile Workstation

computer model

HP EliteBook 8470p
Notebook PC

computer model

 Web-only support:

● Windows XP Pro 32-bit

● Windows 7 Home Basic 64-bit

● Windows 7 Enterprise 64- and 32-bit

● Windows 7 Ultimate 64- and 32-bit

√ √

Serviceability End user replaceable parts:

● AC adapter

● Battery

● Hard drive

● Keyboard

● Memory module

● mSATA drive

● Optical drive

● Solid-state drive

● WLAN module

● WWAN module

√ √
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2 External component identification

Display

Item Component Description

(1) Internal display switch Turns off the display or initiates Suspend if the display is
closed while the power is on.

NOTE: The display switch is not visible from the outside
of the computer.

(2) WLAN antennas (3)* Send and receive wireless signals to communicate
with WLANs.

(3) Internal microphones (2) Record sound.

(4) Webcam light (select models only) On: The webcam is in use.

(5) Webcam (select models only) Records video and captures still photographs.
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Item Component Description

(6) Keyboard light button Turns the keyboard light on or off.

(7) Keyboard light Illuminates the keyboard, especially in low-
light conditions.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region.
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Buttons and fingerprint reader (select models only)
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) TouchPad on/off button Turns the TouchPad on and off.

(2) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button briefly to
initiate Suspend.

● When the computer is in the Suspend state, press
the button briefly to exit Suspend.

● When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and operating
system shutdown procedures are ineffective, press and
hold the power button for at least 5 seconds to turn off
the computer.

To learn more about your power settings:

1. Select Computer > Control Center.

2. In the left pane, click System, and then click
Power Management in the right pane.

(3) Wireless button Turns the wireless feature on or off but does not establish
a wireless connection.
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Item Component Description

(4) Web browser button ● When the computer is on, press the button to open
the default Web browser.

● When the computer is off, in the Suspend state, or
in Hibernation, the button does not perform any
action or function.

(5) Volume mute button Mutes and restores speaker sound.

(6) Fingerprint reader (select models only) Allows a fingerprint logon instead of a password logon.

Keys
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key.

(3) Operating system logo key Displays the operating system menu.

(4) Operating system applications key Displays a shortcut menu for items beneath the cursor.
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Item Component Description

(5) Embedded numeric keypad When the keypad is turned on, it can be used like an
external numeric keypad.

Each key on the keypad performs the function indicated
by the icon in the upper-right corner of the key.

(6) num lk key Turns the embedded numeric keypad on and off when
pressed in combination with the fn key.
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Lights
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) TouchPad light ● Amber: The TouchPad is off.

● Off: The TouchPad is on.

(2) Caps lock light ● On: Caps lock is on.

● Off: Caps lock is off.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Suspend state.

● Off: The computer is off or in Hibernation.

(4) Wireless light ● White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(5) Web browser light ● On: The computer is on.

● Off: The computer is off, in the Suspend state, or
in Hibernation.

(6) Mute light ● Amber: Computer sound is off.

● Off: Computer sound is on.

(7) Num lock light On: Num lock is on.
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TouchPad
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Pointing stick (select models only) Moves the pointer and selects or activates items on
the screen.

(2) Left pointing stick button (select
models only)

Functions like the left button on an external mouse.

(3) TouchPad on/off button Turns the TouchPad on or off.

(4) TouchPad zone Moves the pointer and selects or activates items on
the screen.

(5) Left TouchPad button Functions like the left button on an external mouse.

(6) Right TouchPad button Functions like the right button on an external mouse.

(7) Right pointing stick button (select
models only)

Functions like the right button on an external mouse.
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Front
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Display release latch Opens the computer.

(2) Wireless light ● White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Suspend state.

● Off: The computer is off or in Hibernation.

(4) AC adapter/Battery light ● Amber: The computer is connected to external
power and the battery is charged from 0 to
90 percent.

● White: The computer is connected to external power
and the battery is charged from 90 to 99 percent.

● Blinking amber: A battery that is the only available
power source has reached a low battery level.
When the battery reaches a critical battery level, the
battery light begins blinking rapidly.

● Off: The battery is fully charged.

(5) Hard drive light ● Blinking white: The hard drive or optical drive is
being accessed.

● Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

(6) Speakers (2) Produce sound. One of the speakers is on the bottom of
the computer, and it cannot be seen from the front of
the computer.
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Left side
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Power connector Connects an AC adapter.

(2) 1394 port Connects an optional IEEE 1394 or 1394a device, such
as a camcorder.

(3) USB 3.0 ports (2) Connect optional USB 3.0 devices and provide
enhanced USB power performance.

(4) HP ExpressCard slot or Smart Card reader
(depending on configuration)

Supports optional ExpressCards or smart cards.

(5) Media Card Reader Supports the following digital card formats:

● MultiMediaCard (MMC)

● MMC+

● Secure Digital (SD) Memory Card

● SDHC

● SDXC

(6) Upgrade bay (optical drive shown) The upgrade bay can hold a weight-saver option, a hard
drive, or an optical drive that reads an optical disc.

NOTE: On select models, the optical drive also writes
to an optical disc.

(7) Optical drive eject button (select
models only)

Releases the disc tray.
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Right side
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Audio-out (headphone) jack Produces sound when connected to optional powered
stereo speakers, headphones, earbuds, a headset, or
television audio. Also connects an optional
headset microphone.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
refer to the Regulatory, Safety, and
Environmental Notices.

NOTE: When a device is connected to the jack,
the computer speakers are disabled.

(2) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(3) Smart Card reader Supports optional smart cards.

(4) eSATA/USB 2.0 port Connects an optional high-performance eSATA
component, such as an eSATA external hard drive, or
connects an optional USB device.

(5) USB charging port Connects an optional USB device. The USB charging port
can also charge select models of cell phones and MP3
players, even when the computer is off.

(6) DisplayPort Connects an optional digital display device, such as a
high-performance monitor or projector.
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Item Component Description

(7) Vents (2) Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(8) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

Rear
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) RJ-11 (modem) jack Connects a modem cable.

(2) External monitor port Connects an external VGA monitor or projector.

(3) RJ-45 (network) jack Connects a network cable.
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Bottom
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Vents (4) Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(2) Battery release latch Releases the battery.

(3) Docking connector Connects an optional docking device.

(4) Service cover release latch Releases the service cover from the computer.

(5) Battery bay Holds the battery.

(6) Accessory battery connector Connects an optional accessory battery.

(6) Speakers (2) Produce sound.

Bottom 23



Item Component Description

(7) Bluetooth compartment Contains a Bluetooth device (select models only).

(8) Service cover Provides access to the hard drive, and also contains the
WLAN module slot and the memory module slots.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact support.
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
Battery on page 57 for battery removal instructions.

Item Description Function

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.
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Item Description Function

(3) Part number/Product number (p/n) This number provides specific information about the
product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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Computer major components
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Item Component Spare part number

(1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see Display assembly subcomponents on page 34.

(2) Keyboard with pointing stick for use only on HP EliteBook 8470w Mobile Workstation computer models (includes
keyboard cable and pointing stick cable):

 For use in Belgium 686300-A41

 For use in Brazil 686300-201

 For use in Bulgaria 686300-261

 For use in Canada 686300-DB1

 For use in the Czech Republic and Slovakia 686300-A81

 For use in Denmark 686300-081

 For use in France 686300-051

 For use in Germany 686300-041

 For use in Greece 686300-DJ1

 For use in Hungary 686300-211

 For use in Iceland 686300-DD1

 For use in India 686300-D61

 For use in Israel 686300-BB1

 For use in Italy 686300-061

 For use in Japan 686300-291

 For use in Latin America 686300-161

 For use in the Netherlands 686300-B31

 For use in Norway 686300-091

 For use in Northwest Africa 686300-FP1

 For use in Portugal 686300-131

 For use in Romania 686300-271

 For use in Russia 686300-251

 For use in Saudi Arabia 686300-171

 For use in Slovenia 686300-BA1

 For use in South Korea 686300-AD1

 For use in Spain 686300-071

 For use in Sweden and Finland 686300-B71

 For use in Switzerland 686300-BG1

 For use in Taiwan 686300-AB1
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Item Component Spare part number

 For use in Thailand 686300-281

 For use in Turkey 686300-141

 For use in the United Kingdom and Singapore 686300-031

 For use in the United States 686300-001

(2) Keyboard with pointing stick for use only on HP EliteBook 8470p Notebook PC computer models (includes
keyboard cable and pointing stick cable):

 For use in Belgium 686299-A41

 For use in Brazil 686299-201

 For use in Bulgaria 686299-261

 For use in Canada 686299-DB1

 For use in the Czech Republic and Slovakia 686299-FL1

 For use in Denmark 686299-081

 For use in France 686299-051

 For use in Germany 686299-041

 For use in Greece 686299-DJ1

 For use in Hungary 686299-211

 For use in Iceland 686299-DD1

 For use in India 686299-D61

 For use in Israel 686299-BB1

 For use in Italy 686299-061

 For use in Japan 686299-291

 For use in Latin America 686299-161

 For use in the Netherlands 686299-B31

 For use in Norway 686299-091

 For use in Northwest Africa 686299-FB1

 For use in Portugal 686299-131

 For use in Romania 686299-271

 For use in Russia 686299-251

 For use in Saudi Arabia 686299-171

 For use in Slovenia 686299-BA1

 For use in South Korea 686299-AD1

 For use in Spain 686299-071

 For use in Sweden and Finland 686299-B71
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Item Component Spare part number

 For use in Switzerland 686299-BG1

 For use in Taiwan 686299-AB1

 For use in Thailand 686299-281

 For use in Turkey 686299-141

 For use in the United Kingdom and Singapore 686299-031

 For use in the United States 686299-001

(3) Top cover (includes TouchPad):

 Equipped with pointing stick buttons and a fingerprint reader for use only on HP
EliteBook 8470w Mobile Workstation computer models

686043-001

 Equipped with pointing stick buttons and a fingerprint reader for use only on HP
EliteBook 8470p Notebook PC computer models

686964-001

 Equipped with pointing stick buttons but not a fingerprint reader for use only on HP
EliteBook 8470p Notebook PC computer models

686965-001

(4) Smart Card reader 686025-001

(5) Display lid switch board (includes cable) 684340-001

(6) Fingerprint reader board (includes cable) 684343-001

(7) RTC battery 651948-001

(8) ExpressCard assembly 684345-001

(9) System board (includes replacement thermal material):

 For use only on HP EliteBook 8470w Mobile Workstation computer models:

 For use only on computer models equipped with a graphics subsystem with discrete
memory in all countries and regions except the People's Republic of China and
the Ukraine

686042-001

 For use only on computer models equipped with a graphics subsystem with discrete
memory in the People's Republic of China and the Ukraine

691718-001

 For use only on HP EliteBook 8470p Notebook PC computer models:

 For use only on computer models equipped with a graphics subsystem with discrete
memory in all countries and regions except the People's Republic of China and
the Ukraine

686041-001

 For use only on computer models equipped with a graphics subsystem with discrete
memory in the People's Republic of China and the Ukraine

691717-001

 For use only on computer models equipped with a graphics subsystem with UMA
memory in all countries and regions except the People's Republic of China and
the Ukraine

686040-001

 For use only on computer models equipped with a graphics subsystem with UMA
memory in the People's Republic of China and the Ukraine

691716-001
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Item Component Spare part number

(10) Modem module

NOTE: The RJ-11 jack cable is included in the Cable Kit, spare part number
641830-001.

628824-001

(11) WLAN module:

 Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter 675794-001

 Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter 669832-001

 Intel Centrino Advanced-N 6205 WLAN module 631954-001

 Intel Centrino Ultimate-N 6300 WLAN module 572511-001

 Intel Centrino Wireless-N 2200 802.11b/g/n 2×2 WiFi Adapter 670288-001

(12) Processor (includes replacement thermal material):

 For use only on HP EliteBook 8470w Mobile Workstation computer models:

 Intel Quad Core i7-3820QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-
MHz FSB, 8.0-MB L3 cache, 45 W)

681284-001

 For use on all computer models:

 Intel Quad Core i7-3720QM 2.60-GHz processor (SC turbo up to 3.60-GHz; 1600-
MHz FSB, 6.0-MB L3 cache, 45 W)

681283-001

 Intel Quad Core i7-3610QM 2.30-GHz processor (SC turbo up to 3.30-GHz; 1600-
MHz FSB, 6.0-MB L3 cache, 45 W)

680646-001

 Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz
FSB, 4.0-MB L3 cache, 35 W)

681954-001

 Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

681953-001

 Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

681952-001

 For use only on HP EliteBook 8470p Notebook PC computer models:

 Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

680645-001

 Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 682417-001

(13) Fan (includes cable) 641839-001

(14) Memory modules (PC3-12800, 1666-MHz, DDR3):

 8-GB 670034-001

 4-GB 641369-001

 2-GB 652972-001

(15) WWAN module:

 HP lt2523 LTE/HSPA+ Mobile Broadband Module 675793-001

 HP lt2522 LTE/EV-DO Mobile Broadband Module 675791-001
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Item Component Spare part number

 HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

 HP hs2350 HSPA+ Mobile Broadband Module 668969-001

(16) Heat sink (includes replacement thermal material):

 For use only on computer models equipped with a graphics subsystem with
discrete memory

686021-001

 For use only on computer models equipped with a graphics subsystem with
UMA memory

693371-001

(17) Optical drive (includes optical drive bezel and optical drive bracket):

 For use only on HP EliteBook 8470w Mobile Workstation computer models:

 Blu-ray R/RE DVD±RW SuperMulti DL Drive 686048-001

 Blu-ray ROM DVD±RW SuperMulti DL Drive 689090-001

 DVD±RW Double-Layer with SuperMulti Drive 689078-001

 DVD-ROM Drive 689076-001

 For use only on HP EliteBook 8470p Notebook PC computer models:

 Blu-ray ROM DVD±RW SuperMulti DL Drive 689079-001

 DVD±RW Double-Layer with SuperMulti Drive 689077-001

 DVD-ROM Drive 689075-001

(18) Hard drive (does not include hard drive bracket or screws):

 750-GB, 7200-rpm, 9.5-mm 633252-001

 500-GB, 7200-rpm, 9.5-mm self-encrypting drive 683801-001

 500-GB, 7200-rpm, 9.5-mm 634925-001

 320-GB, 7200-rpm, 9.5-mm 634862-001

 Hard Drive Hardware Kit (not illustrated, includes hard drive bracket and screws) 642774-001

(19) Speaker assembly (includes cable) 641840-001

(20) Bluetooth module 4.0 EDR

NOTE: The Bluetooth module cable is included in the Cable Kit, spare part number
641830-001.

655792-001

(21) Battery (Li ion):

 9-cell, 100-Wh, 3.00-Ah 631243-001

 9-cell, 100-Wh, 3.00-Ah 634087-001

 9-cell, 73-Wh, 2.20-Ah 634089-001

 6-cell, 62-Wh, 2.80-Ah 628668-001

 6-cell, 51-Wh, 2.55-Ah 659083-001

 3-cell, 31-Wh, 2.80-Ah 628664-001
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Item Component Spare part number

(22) Base enclosure (includes rubber feet, service cover release latch assembly, and
battery release latch assembly)

685997-001

 Rubber Kit (not illustrated, includes display bezel left and right rubber screw covers,
base enclosure front and rear rubber screw covers, top cover rubber bumper)

642768-001

 Latch Kit (not illustrated, includes service cover release latch assembly components
and battery release latch assembly components)

684339-001

(23) Service cover 686031-001
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Display assembly subcomponents

Item Component Spare part number

(1) Display bezel:

 For use only on HP EliteBook 8470w Mobile Workstation computer models 686014-001

 For use only on HP EliteBook 8470p Notebook PC computer models 686012-001

(2) Webcam/microphone module 686045-001
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Item Component Spare part number

 Microphone module 642798-001

(3) Display Hinge Kit (includes left and right display hinges and left and right hinge
brackets)

642782-001

 Display Hinge Cover Kit, includes: 686024-001

(4a) Display hinge outer covers (2)

(4b) Display hinge inner covers (2)

(4c) Display hinge tube

(5) 15.6-in, LED, AntiGlare display panel:

 14.0-in, LED, FLT, HD+, AntiGlare display panel 686047-001

 14.0-in, LED, FLT, HD, AntiGlare display panel 686046-001

 14.0-in, LED, SVA, HD+, AntiGlare display panel 684348-001

 14.0-in, LED, SVA, HD, AntiGlare display panel 684347-001

 Display Cable Kit, includes:

(6a) Display panel cable:

(6b) Webcam/microphone module cable:

 For use only on HP EliteBook 8470w Mobile Workstation computer models equipped
with an HD+ display assembly

686019-001

 For use only on HP EliteBook 8470w Mobile Workstation computer models equipped
with an HD display assembly

686017-001

 For use only on HP EliteBook 8470p Notebook PC computer models equipped with an
HD+ display assembly

686018-001

 For use only on HP EliteBook 8470p Notebook PC computer models equipped with an
HD display assembly

686016-001

 Antenna Kit, includes: 685993-001

(7) WWAN antenna cables and transceivers

(8) WLAN antenna cables and transceivers

(9) Display enclosure:

 For use only on HP EliteBook 8470w Mobile Workstation computer models 685996-001

 For use only on HP EliteBook 8470p Notebook PC computer models 685995-001

 Display Panel Support Kit (includes WLAN antenna cables and transceivers, WWAN antenna cables and
transceivers, and display enclosure)

 For use in HP EliteBook 8470w Mobile Workstation computer models 686023-001

 For use in HP EliteBook 8470p Notebook PC computer models 686022-001

 Display Rubber Kit (includes display bezel rubber screw covers and display bezel
rubber bumpers)

642785-001
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Cable Kit

Item Component Spare part number

 Cable Kit, includes: 641830-001

(1) Bluetooth module cable

(2) TouchPad board cable

(3) RJ-11 jack cable
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Mass storage devices

Item Description Spare part number

(1) Hard drive (does not include hard drive bracket or screws):

 750-GB, 7200-rpm, 9.5-mm 633252-001

 500-GB, 7200-rpm, 9.5-mm SED 683801-001

 500-GB, 7200-rpm, 9.5-mm 634925-001

 320-GB, 7200-rpm, 9.5-mm 634862-001

 Hard Drive Hardware Kit, includes: 642774-001

(2) Hard drive bracket
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Item Description Spare part number

 Hard drive bracket screws (not illustrated)

(3) Optical drive (includes optical drive bezel and optical drive bracket):

 For use only on HP EliteBook 8470w Mobile Workstation computer models:

 Blu-ray R/RE DVD±RW SuperMulti DL Drive 686048-001

 Blu-ray ROM DVD±RW SuperMulti DL Drive 689090-001

 DVD±RW Double-Layer with SuperMulti Drive 689078-001

 DVD-ROM Drive 689076-001

 For use only on HP EliteBook 8470p Notebook PC computer models:

 Blu-ray ROM DVD±RW SuperMulti DL Drive 689079-001

 DVD±RW Double-Layer with SuperMulti Drive 689077-001

 DVD-ROM Drive 689075-001

(4) Upgrade bay cradle (includes bezel and bracket) 643921-001

(5) Solid-state drive (does not include solid-state drive bracket or screws):  

 256-GB SATA III self-encrypting solid-state drive 691466-001

 180-GB SATA III solid-state drive 692097-001

 160-GB SATA II solid-state drive 693863-001

 128-GB SATA III solid-state drive 690229-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit:

 For use only on HP EliteBook 8470w Mobile Workstation computer models: 686963-001

 For use only on HP EliteBook 8470p Notebook PC computer models: 686027-001

 Includes:

(1) RJ-11 jack plug

(2) ExpressCard slot space saver

(3) Optical drive bay space saver
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Miscellaneous parts

Component Spare part number

AC adapter:

90-W HP Smart AC adapter (PFC, EM, 3-wire) 693713-001

90-W HP Smart AC adapter (PFC, 3-wire) 693712-001

65-W HP Smart AC adapter (non-PFC, 3-wire) 693711-001

65-W HP Smart AC adapter (RC/V, EM, 3-wire) 693710-001

Carrying case:

HP basic carrying case 455084-001

HP essential nylon case 612757-001

HP professional top-load slim case 592923-001

Lock:

HP notebook computer combination lock 591699-001

HP notebook computer keyed cable lock 626729-001

Optical mouse:

HP USB optical travel mouse 434594-001

HP USB/PS2 2-button optical mouse 390632-001

Power cord (3-pin, black, 1.83-m):

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-202

For use in Denmark 490371-081

For use in Europe 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Japan 490371-291

For use in North America 490371-001

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1
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Component Spare part number

For use in Thailand 490371-201

For use in the United Kingdom and Singapore 490371-031

Screw Kit 686032-001

Sequential part number listing

Spare part number Description

390632-001 HP USB/PS2 2-button optical mouse

434594-001 HP USB optical travel mouse

455084-001 HP basic carrying case

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)

490371-011 Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021 Power cord for use in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-081 Power cord for use in Denmark (3-pin, black, 1.83-m)

490371-111 Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-201 Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-202 Power cord for use in Brazil (3-pin, black, 1.83-m)

490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1 Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)

490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1 Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-AR1 Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)

490371-D01 Power cord for use in Argentina (3-pin, black, 1.83-m)

490371-D61 Power cord for use in India (3-pin, black, 1.83-m)

572511-001 Intel Centrino Ultimate-N 6300 WLAN module

591699-001 HP notebook computer combination lock

592923-001 HP professional top load slim case

612757-001 HP essential nylon case

626729-001 HP notebook computer keyed cable lock

628664-001 3-cell, 31-Wh, 2.80-Ah, Li-ion battery
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Spare part number Description

628668-001 6-cell, 62-Wh, 2.80-Ah, Li-ion battery

628824-001 Modem module (does not include the RJ-11 jack cable)

NOTE: The RJ-11 jack cable is included in the Cable Kit, spare part number 641830-001.

631243-001 9-cell, 100-Wh, 3.0-Ah, Li-ion battery

631954-001 Intel Centrino Advanced-N 6205 WLAN module

633252-001 750-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 642774-001.

634087-001 9-cell, 100-Wh, 3.00-Ah, Li-ion battery

634089-001 6-cell, 73-Wh, 2.20-Ah, Li-ion battery

634400-001 HP un2430 EV-DO/HSPA Mobile Broadband Module

634862-001 320-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 642774-001.

634925-001 500-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 642774-001.

641369-001 4-GB memory module (PC3, 12800, 1600-MHz)

641830-001 Cable Kit (includes Bluetooth module cable, RJ-11 jack cable, and TouchPad cable)

641839-001 Fan (includes cable)

641840-001 Speaker assembly (includes cable)

642768-001 Rubber Kit (includes rubber bumpers)

642774-001 Hard Drive Hardware Kit (includes hard drive bracket and screws)

642782-001 Display Hinge Kit (includes left and right hinges and left and right hinge brackets)

642785-001 Display Rubber Kit (includes display bezel rubber screw covers and display bezel rubber bumpers)

642798-001 Microphone module

643921-001 Upgrade bay cradle

651948-001 RTC battery (includes cable and double-sided tape)

652972-001 2-GB memory module (PC3, 12800, 1600-MHz)

655792-001 Bluetooth module 4.0 EDR (does not include the Bluetooth module cable)

NOTE: The Bluetooth module cable is included in the Cable Kit, spare part number 641830-001.

659083-001 6-cell, 51-Wh, 2.55-Ah, Li-ion battery

668969-001 HP hs2350 HSPA+ Mobile Broadband Module
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Spare part number Description

669832-001 Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter

670034-001 8-GB memory module (PC3, 12800, 1600-MHz)

670288-001 Intel Centrino Wireless-N 2200 802.11b/g/n 2×2 WiFi Adapter

675791-001 HP lt2522 LTE/EV-DO Mobile Broadband Module

675793-001 HP lt2523 LTE/HSPA+ Mobile Broadband Module

675794-001 Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter

680645-001 Intel Dual Core i5-3210M 2.50-GHz processor for use only on HP EliteBook 8470p Notebook PC
computer models (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes
replacement thermal material)

680646-001 Intel Quad Core i7-3610QM 2.30-GHz processor for use on all computer models (SC turbo up to
3.30-GHz; 1600-MHz FSB, 6.0-MB L3 cache, 45 W; includes replacement thermal material)

681283-001 Intel Quad Core i7-3720QM 2.60-GHz processor for use on all computer models (SC turbo up to
3.60-GHz; 1600-MHz FSB, 6.0-MB L3 cache, 45 W; includes replacement thermal material)

681284-001 Intel Quad Core i7-3820QM 2.70-GHz processor for use only on HP EliteBook 8470w Mobile
Workstation computer models (SC turbo up to 3.70-GHz; 1600-MHz FSB, 8.0-MB L3 cache,
45 W; includes replacement thermal material)

681952-001 Intel Dual Core i5-3320M 2.60-GHz processor for use on all computer models (SC turbo up to
3.30-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes replacement thermal material)

681953-001 Intel Dual Core i5-3360M 2.80-GHz processor for use on all computer models (SC turbo up to
3.50-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes replacement thermal material)

681954-001 Intel Dual Core i7-3520M 2.90-GHz processor for use on all computer models (SC turbo up to
3.60-GHz; 1600-MHz FSB, 4.0-MB L3 cache, 35 W; includes replacement thermal material)

682417-001 Intel Core i3-3110M 2.40-GHz processor for use only on HP EliteBook 8470p Notebook PC
computer models (1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes replacement thermal material)

683801-001 500-GB, 7200-rpm, 9.5-mm SED hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 642774-001.

684339-001 Latch Kit (includes service cover release latch assembly components and battery release latch
assembly components)

684340-001 Display lid switch board

684343-001 Fingerprint reader board (includes cable)

684345-001 ExpressCard assembly

684347-001 14.0-in, LED, SVA, HD, AntiGlare display panel

684348-001 14.0-in, LED, SVA, HD+, AntiGlare display panel

685993-001 Antenna Kit (includes left and right WLAN antenna cables and transceivers and left and right
WWAN antenna cables and transceivers)

685995-001 Display enclosure for use only on HP EliteBook 8470p Notebook PC computer models

685996-001 Display enclosure for use only on HP EliteBook 8470w Mobile Workstation computer models

Sequential part number listing 43



Spare part number Description

685997-001 Base enclosure (includes four rubber feet, service cover release latch assembly, and battery
release latch assembly)

686012-001 Display bezel for use only on HP EliteBook 8470p Notebook PC computer models

686014-001 Display bezel for use only on HP EliteBook 8470w Mobile Workstation computer models

686016-001 Display panel cable for use only on HP EliteBook 8470p Notebook PC computer models equipped
with an HD display assembly

686017-001 Display panel cable for use only on HP EliteBook 8470w Mobile Workstation computer models
equipped with an HD display assembly

686018-001 Display panel cable for use only on HP EliteBook 8470p Notebook PC computer models equipped
with an HD+ display assembly

686019-001 Display panel cable for use only on HP EliteBook 8470w Mobile Workstation computer models
equipped with an HD+ display assembly

686021-001 Heat sink for use on computer models equipped with a graphics subsystem with discrete memory

686022-001 Display Panel Support Kit for use only on HP EliteBook 8470p Notebook PC computer models
(includes display enclosure, WLAN antenna cables and transceivers, and WWAN antenna cables
and transceivers)

686023-001 Display Panel Support Kit for use only on HP EliteBook 8470w Mobile Workstation computer
models (includes display enclosure, WLAN antenna cables and transceivers, and WWAN antenna
cables and transceivers)

686024-001 Display Hinge Cover Kit (includes hinge tube, left and right hinge covers, cable guides, left and
right inner covers, and left and right outer covers)

686025-001 Smart Card reader

686027-001 Plastics Kit for use only on HP EliteBook 8470p Notebook PC computer models (includes
ExpressCard slot space saver, optical drive bay space saver, RJ-11 jack cover, and wireless
antenna clips)

686031-001 Service cover

686032-001 Screw Kit

686040-001 System board for use only on HP EliteBook 8470p Notebook PC computer models equipped with a
graphics subsystem with UMA memory in all countries and regions except the People's Republic of
China and the Ukraine (includes replacement thermal material)

686041-001 System board for use only on HP EliteBook 8470p Notebook PC computer models equipped with a
graphics subsystem with discrete memory in all countries and regions except the People's Republic
of China and the Ukraine (includes replacement thermal material)

686042-001 System board for use only on HP EliteBook 8470w Mobile Workstation computer models equipped
with a graphics subsystem with discrete memory in all countries and regions except the People's
Republic of China and the Ukraine (includes replacement thermal material)

686043-001 Top cover with pointing stick buttons and a fingerprint reader for use only on HP EliteBook 8470w
Mobile Workstation computer models (includes TouchPad)

686045-001 Webcam/microphone module (includes double-sided tape)

686046-001 14.0-in, LED, FLT, HD, AntiGlare display panel

686047-001 14.0-in, LED, FLT, HD+, AntiGlare display panel
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Spare part number Description

686048-001 Blu-ray R/RE DVD±RW SuperMulti DL Drive (for use only on HP EliteBook 8470w Mobile
Workstation computer models; includes bezel and bracket)

686299-001 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in the
United States (includes keyboard cable and pointing stick cable)

686299-031 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in the
United Kingdom and Singapore (includes keyboard cable and pointing stick cable)

686299-041 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Germany (includes keyboard cable and pointing stick cable)

686299-051 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
France (includes keyboard cable and pointing stick cable)

686299-061 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in Italy
(includes keyboard cable and pointing stick cable)

686299-071 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Spain (includes keyboard cable and pointing stick cable)

686299-081 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Denmark (includes keyboard cable and pointing stick cable)

686299-091 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Norway (includes keyboard cable and pointing stick cable)

686299-131 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Portugal (includes keyboard cable and pointing stick cable)

686299-141 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Turkey (includes keyboard cable and pointing stick cable)

686299-161 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in Latin
America (includes keyboard cable and pointing stick cable)

686299-171 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Saudi Arabia (includes keyboard cable and pointing stick cable)

686299-201 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Brazil (includes keyboard cable and pointing stick cable)

686299-211 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Hungary (includes keyboard cable and pointing stick cable)

686299-251 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Russia (includes keyboard cable and pointing stick cable)

686299-261 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Bulgaria (includes keyboard cable and pointing stick cable)

686299-271 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Romania (includes keyboard cable and pointing stick cable)

686299-281 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Thailand (includes keyboard cable and pointing stick cable)

686299-291 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Japan (includes keyboard cable and pointing stick cable)
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Spare part number Description

686299-A41 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Belgium (includes keyboard cable and pointing stick cable)

686299-AB1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Taiwan (includes keyboard cable and pointing stick cable)

686299-AD1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
South Korea (includes keyboard cable and pointing stick cable)

686299-B31 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in the
Netherlands (includes keyboard cable and pointing stick cable)

686299-B71 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Sweden and Finland (includes keyboard cable and pointing stick cable)

686299-BA1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Slovenia (includes keyboard cable and pointing stick cable)

686299-BB1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Israel (includes keyboard cable and pointing stick cable)

686299-BG1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Switzerland (includes keyboard cable and pointing stick cable)

686299-D61 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
India (includes keyboard cable and pointing stick cable)

686299-DB1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Canada (includes keyboard cable and pointing stick cable)

686299-DD1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Iceland (includes keyboard cable and pointing stick cable)

686299-DJ1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Greece (includes keyboard cable and pointing stick cable)

686299-FB1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in
Northwest Africa (includes keyboard cable and pointing stick cable)

686299-FL1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models in the
Czech Republic and Slovakia (includes keyboard cable and pointing stick cable)

686300-001 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in the United States (includes keyboard cable and pointing stick cable)

686300-031 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in the United Kingdom and Singapore (includes keyboard cable and pointing stick cable)

686300-041 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Germany (includes keyboard cable and pointing stick cable)

686300-051 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in France (includes keyboard cable and pointing stick cable)

686300-061 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Italy (includes keyboard cable and pointing stick cable)

686300-071 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Spain (includes keyboard cable and pointing stick cable)
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Spare part number Description

686300-081 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Denmark (includes keyboard cable and pointing stick cable)

686300-091 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Norway (includes keyboard cable and pointing stick cable)

686300-131 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Portugal (includes keyboard cable and pointing stick cable)

686300-141 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Turkey (includes keyboard cable and pointing stick cable)

686300-161 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Latin America (includes keyboard cable and pointing stick cable)

686300-171 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Saudi Arabia (includes keyboard cable and pointing stick cable)

686300-201 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Brazil (includes keyboard cable and pointing stick cable)

686300-211 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Hungary (includes keyboard cable and pointing stick cable)

686300-251 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Russia (includes keyboard cable and pointing stick cable)

686300-261 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Bulgaria (includes keyboard cable and pointing stick cable)

686300-271 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Romania (includes keyboard cable and pointing stick cable)

686300-281 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Thailand (includes keyboard cable and pointing stick cable)

686300-291 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Japan (includes keyboard cable and pointing stick cable)

686300-A41 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Belgium (includes keyboard cable and pointing stick cable)

686300-A81 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in the Czech Republic and Slovakia (includes keyboard cable and pointing stick cable)

686300-AB1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Taiwan (includes keyboard cable and pointing stick cable)

686300-AD1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in South Korea (includes keyboard cable and pointing stick cable)

686300-B31 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in the Netherlands (includes keyboard cable and pointing stick cable)

686300-B71 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Sweden and Finland (includes keyboard cable and pointing stick cable)

686300-BA1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Slovenia (includes keyboard cable and pointing stick cable)
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686300-BB1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Israel (includes keyboard cable and pointing stick cable)

686300-BG1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Switzerland (includes keyboard cable and pointing stick cable)

686300-D61 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in India (includes keyboard cable and pointing stick cable)

686300-DB1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Canada (includes keyboard cable and pointing stick cable)

686300-DD1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Iceland (includes keyboard cable and pointing stick cable)

686300-DJ1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Greece (includes keyboard cable and pointing stick cable)

686300-FP1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
in Northwest Africa (includes keyboard cable and pointing stick cable)

686963-001 Plastics Kit W (includes ExpressCard slot space saver, optical drive bay space saver, RJ-11 jack
plug, and wireless antenna clips)

686964-001 Top cover with pointing stick buttons for use only on HP EliteBook 8470p Notebook PC computer
models equipped with a fingerprint reader (includes TouchPad)

686965-001 Top cover with pointing stick buttons for use only on HP EliteBook 8470p Notebook PC computer
models not equipped with a fingerprint reader (includes TouchPad)

689075-001 DVD-ROM Drive for use only on HP EliteBook 8470p Notebook PC computer models (includes
bezel and bracket)

689076-001 DVD-ROM Drive for use only on HP EliteBook 8470w Mobile Workstation computer models
(includes bezel and bracket)

689077-001 DVD±RW Double-Layer with SuperMulti Drive for use only on HP EliteBook 8470p Notebook PC
computer models (includes bezel and bracket)

689078-001 DVD±RW Double-Layer with SuperMulti Drive for use only on HP EliteBook 8470w Mobile
Workstation computer models (includes bezel and bracket)

689079-001 Blu-ray ROM DVD±RW SuperMulti DL Drive for use only on HP EliteBook 8470p Notebook PC
computer models (includes bezel and bracket)

689080-001 Blu-ray ROM DVD±RW SuperMulti DL Drive for use only on HP EliteBook 8470w Mobile
Workstation computer models (includes bezel and bracket)

689954-001 24-GB flash cache module

690229-001 128-GB SATA III solid-state drive

691466-001 256-GB SATA III self-encrypting solid-state drive

691716-001 System board for use only on HP EliteBook 8470p Notebook PC computer models equipped with a
graphics subsystem with UMA memory in the People's Republic of China and the Ukraine (includes
replacement thermal material)

691717-001 System board for use only on HP EliteBook 8470p Notebook PC computer models equipped with a
graphics subsystem with discrete memory in the People's Republic of China and the Ukraine
(includes replacement thermal material)
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691718-001 System board for use only on HP EliteBook 8470w Mobile Workstation computer models equipped
with a graphics subsystem with discrete memory in the People's Republic of China and the Ukraine
(includes replacement thermal material)

692097-001 180-GB SATA III solid-state drive

693371-001 Heat sink for use only on computer models equipped with a graphics subsystem with UMA memory
(includes replacement thermal material)

693710-001 65-W HP Smart AC adapter (RC/V, EM, 3-wire)

693711-001 65-W HP Smart AC adapter (non-PFC, 3-wire)

693712-001 90-W HP Smart AC adapter (PFC, 3-wire)

693713-001 90-W HP Smart AC adapter (PFC, EM, 3-wire)

693863-001 160-GB SATA II solid-state drive

697439-001 Display Miscellaneous Kit
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screw driver

● Magnetic screw driver

● Phillips P0 and P1 screw drivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.
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Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

Preliminary replacement requirements 51



CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screw drivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 73 screws that must be removed, replaced, and/or loosened when servicing the
computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 57 for battery removal instructions.

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.
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Item Component Description

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare part
number 642768-001. There are 4 rectangular rubber feet (1) and two square rubber feet (2) that
attach to the base enclosure and service cover in the locations illustrated below.
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Battery

Description Spare part number

9-cell, 100-Wh, 3.00-Ah, Li ion 631243-001

9-cell, 100-Wh, 3.00-Ah, Li ion 634087-001

9-cell, 73-Wh, 2.20-Ah, Li ion 634089-001

6-cell, 62-Wh, 2.80-Ah, Li ion 628668-001

6-cell, 51-Wh, 2.55-Ah, Li ion 659083-001

3-cell, 31-Wh, 2.80-Ah, Li ion 628664-001

Before disassembling the computer, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

Remove the battery:

1. Position the computer upside-down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Remove the battery (2) from the computer.
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Install the battery by inserting it into the battery bay until you hear a click.

SIM

NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Service cover

Description Spare part number

Service cover 686031-001

Before removing the service cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57).

Remove the service cover:

1. Slide the release latch (1) and remove the locking screw (if installed) (2).

2. Slide the release latch (3) to disengage the door from the computer.

3. Slide the door toward the front of the computer (4), and then lift the door off the computer (5).

Reverse the removal procedures to install the service cover.
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Smart Card reader

Description Spare part number

Smart Card reader 686025-001

Before removing the Smart Card reader, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57).

5. Remove the service cover (see Service cover on page 59).

Remove the Smart Card reader:

1. Disconnect the Smart Card reader cable (1) from the low insertion force (LIF) connector on the
system board.

2. Use the Smart Card reader tab (2) to lift the left side of the Smart Card reader (3) and swing it up
and to the right.

3. Detach the clips (4) on the right side of the Smart Card reader from the base enclosure.

4. Remove the Smart Card reader by sliding it up and the left at an angle (5).

Reverse the removal procedures to install the Smart Card reader.
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Optical drive

NOTE: The optical drive spare part kit includes an optical drive bezel and optical drive bracket.

Description Spare part number

For use only on HP EliteBook 8470w Mobile Workstation computer models:

Blu-ray R/RE DVD±RW SuperMulti DL Drive 686048-001

Blu-ray ROM DVD±RW SuperMulti DL Drive 689090-001

DVD±RW Double-Layer with SuperMulti Drive 689078-001

DVD-ROM Drive 689076-001

For use only on HP EliteBook 8470p Notebook PC computer models:

Blu-ray ROM DVD±RW SuperMulti DL Drive 689079-001

DVD±RW Double-Layer with SuperMulti Drive 689077-001

DVD-ROM Drive 689075-001

Before removing the optical drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57).

5. Remove the service cover (see Service cover on page 59).

Remove the optical drive:

1. Position the computer upside-down with the right side toward you.

2. Loosen the captive Phillips screw (1) that secures the optical drive to the computer.

3. Use a flat-blade screw driver or similar tool to press on the optical drive bracket tab (2) to release
the optical drive.
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4. Remove the optical drive (3) from the computer.

5. If it is necessary to replace the optical drive bezel, use a thin tool or an unbent paper clip (1) to
release the optical drive tray.

6. Use a flat-blade screw driver or similar tool to press on the optical drive bezel tab (2), and then
release the left side of the optical drive bezel (3).

7. Remove the optical drive bezel (4).

8. If it is necessary to replace the optical drive bracket, position the optical drive with the rear panel
toward you.

9. Remove the three Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the
optical drive.
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10. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.

Upgrade bay cradle

Description Spare part number

Upgrade bay cradle (includes bezel and bracket) 643921-001

Before removing the upgrade bay cradle, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57).

5. Remove the service cover (see Service cover on page 59).

Remove the upgrade bay cradle:

1. Position the computer upside-down with the right side toward you.
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2. Remove the four Phillips PM2.0×4.0 screws that secure the upgrade bay cradle to the computer.

3. Loosen the captive Phillips screw that secures the upgrade bay cradle in the upgrade bay (1).

4. Use a flat-blade screw driver or similar tool to press on the upgrade bay bracket tab (2) to release
the upgrade bay.

5. Remove the upgrade bay (3) from the computer.

Reverse this procedure to install the upgrade bay.
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Hard drive

NOTE: The hard drive spare part kit does not include the hard drive bracket or screws.

Description Spare part number

750-GB, 7200-rpm, 9.5-mm 633252-001

500-GB, 7200-rpm, 9.5-mm SED 683801-001

500-GB, 7200-rpm, 9.5-mm 634925-001

320-GB, 7200-rpm, 9.5-mm 634862-001

Hard Drive Hardware Kit (includes hard drive bracket and screws) 642774-001

Before removing the hard drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57).

5. Remove the service cover (see Service cover on page 59).

6. Remove the Smart Card reader (see Smart Card reader on page 60).

Remove the hard drive:

1. Loosen the three Phillips screws (1) that secure the hard drive to the computer.

2. Use the hard drive tab (2) to slide the hard drive to the right to disconnect it from the
system board.
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3. Remove the hard drive (3) from the hard drive bay.

4. If it is necessary to disassemble the hard drive, perform the following steps:

a. Remove the four Phillips PM3.0×3.0 screws (1) that secure the hard drive bracket to the
hard drive.

b. Remove the hard drive bracket (2) from the hard drive. The hard drive bracket and screws
are available in the Hard Drive Hardware Kit, spare part number 642774-001.

Reverse this procedure to reassemble and install the hard drive.
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Memory module

NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom of
the computer.

Description Spare part number

8-GB memory module (PC3, 12800, 1600-MHz) 670034-001

4-GB memory module (PC3, 12800, 1600-MHz) 641369-001

2-GB memory module (PC3, 12800, 1600-MHz) 652972-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1. Navigate to www.hp.com.

2. Click Support & Drivers > click Drivers & Software.

3. In the Enter a product name/number box, type the computer model information, and then
click Search.

4. Click the link for the computer model.

5. Select the operating system, and then click Next.

6. Under Step 2: Select a Download, click the BIOS link.

7. Click the link for the most recent BIOS.

8. Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57).

5. Remove the service cover (see Service cover on page 59).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

NOTE: The computer uses two memory slots. The top slot houses the expansion memory module
and is shown in the first image below. The bottom slot houses the primary memory module and is
shown in the second image below.

Reverse this procedure to install a memory module.
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WWAN module

NOTE: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number

HP lt2523 LTE/HSPA+ Mobile Broadband Module 675793-001

HP lt2522 LTE/EV-DO Mobile Broadband Module 675791-001

HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

HP hs2350 HSPA+ Mobile Broadband Module 668969-001

Before removing the WWAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57).

5. Remove the service cover (see Service cover on page 59).

Remove the WWAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to the
system board. (The WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

NOTE: If the WWAN antennas are not connected to the terminals on the WWAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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WLAN module

Description Spare part number

Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter 675794-001

Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter 669832-001

Intel Centrino Advanced-N 6205 WLAN module 631954-001

Intel Centrino Ultimate-N 6300 WLAN module 572511-001

Intel Centrino Wireless-N 2200 802.11b/g/n 2×2 WiFi Adapter 670288-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57).

5. Remove the service cover (see Service cover on page 59).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal
labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellow
WLAN antenna cable connects to the middle terminal on the WLAN module.

2. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to the
system board. (The WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Bluetooth module

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 641830-001.

Description Spare part number

Bluetooth module 4.0 EDR 655792-001

Before removing the Bluetooth module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57).

5. Remove the service cover (see Service cover on page 59).

Remove the Bluetooth module:

1. Disconnect the Bluetooth module cable (1) from the system board.

2. Release the Bluetooth module (2) from the clip built into the base enclosure.

3. Remove the Bluetooth module.

Reverse this procedure to install the Bluetooth module.
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Modem module

NOTE: The modem module spare part kit does not include an RJ-11 jack cable. The RJ-11 jack cable
is included in the Cable Kit, spare part number 641830-001.

Description Spare part number

Modem module 628824-001

Before removing the modem module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57).

5. Remove the service cover (see Service cover on page 59).

Remove the modem module:

1. Remove the two Phillips PM2.0×3.0 screws (1) that secure the modem module to the
system board.

2. Disconnect the modem module (2) from the system board by lifting it straight up.

3. Disconnect the RJ-11 jack cable (3) from the modem module.

4. Remove the modem module.

Reverse this procedure to install the modem module.
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Fan

Description Spare part number

Fan (includes cable) 641839-001

Before removing the fan, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57).

5. Remove the service cover (see Service cover on page 59).

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Loosen the captive Phillips screw (2) that secures the fan to the top cover.

3. Remove the Phillips PM2.5×5.0 screw (3) that secures the fan to the top cover.

4. Remove the fan (4).

Reverse this procedure to install the fan.
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Keyboard

For use in country/region Spare part
number

For use in country/region Spare part
number

Keyboard with pointing stick for use only on HP EliteBook 8470w Mobile Workstation computer models
(includes keyboard cable and pointing stick cable):

For use in Belgium 686300-A41 For use in Norway 686300-091

For use in Brazil 686300-201 For use in Northwest Africa 686300-FP1

For use in Bulgaria 686300-261 For use in Portugal 686300-131

For use in Canada 686300-DB1 For use in Romania 686300-271

For use in the Czech Republic
and Slovakia

686300-A81 For use in Russia 686300-251

For use in Denmark 686300-081 For use in Saudi Arabia 686300-171

For use in France 686300-051 For use in Slovenia 686300-BA1

For use in Germany 686300-041 For use in South Korea 686300-AD1

For use in Greece 686300-DJ1 For use in Spain 686300-071

For use in Hungary 686300-211 For use in Sweden and Finland 686300-B71

For use in Iceland 686300-DD1 For use in Switzerland 686300-BG1

For use in India 686300-D61 For use in Taiwan 686300-AB1

For use in Israel 686300-BB1 For use in Thailand 686300-281

For use in Italy 686300-061 For use in Turkey 686300-141

For use in Japan 686300-291 For use in the United Kingdom
and Singapore

686300-031

For use in Latin America 686300-161 For use in the United States 686300-001

For use in the Netherlands 686300-B31   

Keyboard with pointing stick for use only on HP EliteBook 8470p Notebook PC computer models
(includes keyboard cable and pointing stick cable):

For use in Belgium 686300-A41 For use in Norway 686300-091

For use in Brazil 686300-201 For use in Northwest Africa 686300-FB1

For use in Bulgaria 686300-261 For use in Portugal 686300-131

For use in Canada 686300-DB1 For use in Romania 686300-271

For use in the Czech Republic
and Slovakia

686300-FL1 For use in Russia 686300-251

For use in Denmark 686300-081 For use in Saudi Arabia 686300-171

For use in France 686300-051 For use in Slovenia 686300-BA1

For use in Germany 686300-041 For use in South Korea 686300-AD1
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For use in country/region Spare part
number

For use in country/region Spare part
number

For use in Greece 686300-DJ1 For use in Spain 686300-071

For use in Hungary 686300-211 For use in Sweden and Finland 686300-B71

For use in Iceland 686300-DD1 For use in Switzerland 686300-BG1

For use in India 686300-D61 For use in Taiwan 686300-AB1

For use in Israel 686300-BB1 For use in Thailand 686300-281

For use in Italy 686300-061 For use in Turkey 686300-141

For use in Japan 686300-291 For use in the United Kingdom
and Singapore

686300-031

For use in Latin America 686300-161 For use in the United States 686300-001

For use in the Netherlands 686300-B31   

Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57).

5. Remove the service cover (see Service cover on page 59).
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Remove the keyboard:

1. Loosen the three Phillips captive screws that secure the keyboard to the computer.

2. Rest and secure the computer on its right side.

3. Partially open the computer.

4. Insert a screw driver or similar thin tool into the keyboard release opening in the battery bay, and
then press on the back of the keyboard until the keyboard disengages from the computer.

5. Turn the computer right-side up with the front toward you.
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6. Lift the rear edge of the keyboard (1), and then swing the keyboard up and forward (2) until it
rests upside down on the palm rest.

7. Release the zero insertion force (ZIF) connector to which the pointing stick cable is attached, and
then disconnect the pointing stick cable (1) from the keyboard.

8. Release the ZIF connector (2) to which the keyboard cable is attached, and then disconnect the
keyboard cable (3) from the system board.

9. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Base enclosure

Description Spare part number

Base enclosure (includes four rubber feet, service cover release latch assembly, and battery
release latch assembly)

685997-001

Before removing the base enclosure, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57), and then remove the following components:

a. Service cover (see Service cover on page 59)

b. Smart Card reader (see Smart Card reader on page 60)

c. Optical drive (see Optical drive on page 61)

d. Hard drive (see Hard drive on page 65)

e. Modem module (see Modem module on page 74)

f. Keyboard (see Keyboard on page 76)

NOTE: When replacing the base enclosure, be sure to remove the following components from the
defective base enclosure and install them on the replacement base enclosure:

● Bluetooth module and cable (see Bluetooth module on page 73)

● Speaker assembly (see Speaker assembly on page 83)

● RJ-11 jack assembly (see RJ-11 jack cable on page 85)

Remove the base enclosure:

1. Close the computer.

2. Turn the computer upside down, with the front toward you.

3. Remove the four rubber screw covers (1). The rubber screw covers are included in the Rubber Kit,
spare part number 642768-001.

4. Remove the eight Torx PM2.5×8.0 screws (2) that secure the base enclosure to the computer.
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5. Remove the two Phillips PM2.5×11.0 screws from the docking connector alignment guides (3) that
secure the base enclosure to the computer.

6. Remove the following screws that secure the base enclosure to the computer:

(1) One Phillips PM2.0×3.0 screw from the hard drive bay

(2) Two Phillips PM2.0×3.0 screws from the battery bay

(3) One Phillips PM2.0×4.0 broad head screw from the battery bay

(4) Two Phillips PM2.5×4.5 screws from the optical drive bay

7. Position the computer with the battery bay toward you.

8. Remove the four Torx TM2.5×8.0 screws (1) from the rear panel of the computer.

Component replacement procedures 81



9. Disconnect the speaker cable from the system board connector (2).

10. Remove the bottom cover from the computer.

NOTE: Thoroughly clean the thermal pad material from the surfaces of the base enclosure (1) and
the PCH chip (2) each time you remove the base enclosure. All base enclosure and system board spare
part kits include replacement thermal pad material.
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Reverse this procedure to install the base enclosure.

Speaker assembly

Description Spare part number

Speaker assembly (includes cable) 641840-001

Before removing the speaker assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57), and then remove the following components:

a. Service cover (see Service cover on page 59)

b. Smart Card reader (see Smart Card reader on page 60)

c. Optical drive (see Optical drive on page 61)

d. Hard drive (see Hard drive on page 65)

e. Modem module (see Modem module on page 74)

f. Keyboard (see Keyboard on page 76)

g. Base enclosure (see Base enclosure on page 80)

Remove the speaker assembly:

1. Turn the base enclosure right-side up, with the front toward you.
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2. Release the speaker cable (1) from the clips (2) and routing channel built into the base enclosure.
Note that the cable routes from inside the base enclosure to outside the base enclosure.

3. Turn the base enclosure upside down, with the front toward you.

4. Remove the two Phillips PM2.0×5.0 screws (1) that secure the speaker assembly to the
base enclosure.

5. Remove the speaker assembly (2) from the base enclosure.

Reverse this procedure to install the speaker assembly.
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RJ-11 jack cable

NOTE: The RJ-11 jack cable is included in the Cable Kit, spare part number 641830-001.

Before removing the RJ-11 jack cable, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57), and then remove the following components:

a. Service cover (see Service cover on page 59)

b. Smart Card reader (see Smart Card reader on page 60)

c. Optical drive (see Optical drive on page 61)

d. Hard drive (see Hard drive on page 65)

e. Modem module (see Modem module on page 74)

f. Keyboard (see Keyboard on page 76)

g. Base enclosure (see Base enclosure on page 80)

Remove the RJ-11 jack cable:

1. Turn the base enclosure right-side up, with the front toward you.

2. Release the RJ-11 jack from the clip (1) built into the base enclosure.
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3. Release the RJ-11 jack cable from the clips (2) and routing channel built into the base enclosure.

4. Remove the RJ-11 jack cable.

Reverse this procedure to install the RJ-11 jack cable.

Service cover release latch assembly

NOTE: The service cover release latch assembly components are included in the Latch Kit, spare part
number 684339-001.

Before removing the service cover release latch assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57), and then remove the following components:

a. Service cover (see Service cover on page 59)

b. Smart Card reader (see Smart Card reader on page 60)

c. Optical drive (see Optical drive on page 61)

d. Hard drive (see Hard drive on page 65)

e. Modem module (see Modem module on page 74)

f. Keyboard (see Keyboard on page 76)

g. Base enclosure (see Base enclosure on page 80)
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Remove the service cover release latch assembly:

1. Position the base enclosure with the front toward you.

2. Remove the service cover release latch actuator from the base enclosure.

3. Turn the base enclosure upside down, with the front toward you.

4. Remove the service cover release latch arm spring from the spring retention hooks on the service
cover release latch arm (1) and the base enclosure (2).

5. Slide the service cover release latch arm (1) as far to the left as it will go.

6. Flex the middle of the service cover release latch arm (2) up and back until it releases from the
track built into the base enclosure.
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7. Lift the left end of the service cover release latch arm (3) out of the openings in the base enclosure.

8. Swing the left end of the service cover release latch arm (1) toward the back of the computer.

9. Release the right end of the service cover release latch arm (2) from the openings in the
base enclosure.

10. Remove the service cover release latch arm.

Reverse this procedure to install the service cover release latch assembly.
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Battery release latch assembly

NOTE: The battery release latch assembly components are included in the Latch Kit, spare part
number 684339-001.

Before removing the battery release latch assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57), and then remove the following components:

a. Service cover (see Service cover on page 59)

b. Smart Card reader (see Smart Card reader on page 60)

c. Optical drive (see Optical drive on page 61)

d. Hard drive (see Hard drive on page 65)

e. Modem module (see Modem module on page 74)

f. Keyboard (see Keyboard on page 76)

g. Base enclosure (see Base enclosure on page 80)

Remove the battery release latch assembly:

1. Position the base enclosure with the front toward you.

2. Remove the battery release latch actuator from the base enclosure.

3. Turn the base enclosure upside down, with the front toward you.
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4. Remove the battery release latch arm spring from the spring retention hooks on the
base enclosure (1) and the battery release latch arm (2).

5. Slide the battery release latch arm (1) as far to the right as it will go.

6. Lift the right end of the battery release latch arm (2) until it is clear of the retention post built into
the base enclosure.

7. Swing the right end of the battery release latch arm (3) clockwise until it is clear of the retention
post built into the base enclosure.

8. Slide the battery release latch arm (1) as far to the left as it will go.
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9. Swing the right end of the battery release latch arm (2) clockwise until the left end of the arm
release from the openings in the base enclosure.

10. Remove the battery release latch arm.

Reverse this procedure to install the battery release latch assembly.
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Fingerprint reader board

Description Spare part number

Fingerprint reader board (includes cable) 684343-001

Before removing the fingerprint reader board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57), and then remove the following components:

a. Service cover (see Service cover on page 59)

b. Smart Card reader (see Smart Card reader on page 60)

c. Optical drive (see Optical drive on page 61)

d. Hard drive (see Hard drive on page 65)

e. Modem module (see Modem module on page 74)

f. Keyboard (see Keyboard on page 76)

g. Base enclosure (see Base enclosure on page 80)

Remove the fingerprint reader board:

1. Position the computer with the front toward you.

2. Disconnect the fingerprint reader board cable (1) from the LIF connector on the system board.
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3. Detach the fingerprint reader board (2) from the clips built into the top cover.

4. Remove the fingerprint reader board and cable.

Reverse this procedure to install the fingerprint reader board.
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RTC battery

Description Spare part number

RTC battery (includes cable and double-sided tape) 652650-001

Before removing the RTC battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57), and then remove the following components:

a. Service cover (see Service cover on page 59)

b. Smart Card reader (see Smart Card reader on page 60)

c. Optical drive (see Optical drive on page 61)

d. Hard drive (see Hard drive on page 65)

e. Modem module (see Modem module on page 74)

f. Keyboard (see Keyboard on page 76)

g. Base enclosure (see Base enclosure on page 80)

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the TouchPad.
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2. Detach the RTC battery (2) from the TouchPad. (The RTC battery is attached to the TouchPad with
double-sided tape.)

3. Remove the RTC battery.

Reverse this procedure to install the RTC battery.

Display lid switch board

Description Spare part number

Display lid switch board (includes cable) 684340-001

Before removing the display lid switch board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57), and then remove the following components:

a. Service cover (see Service cover on page 59)

b. Smart Card reader (see Smart Card reader on page 60)

c. Optical drive (see Optical drive on page 61)

d. Hard drive (see Hard drive on page 65)

e. Modem module (see Modem module on page 74)

f. Keyboard (see Keyboard on page 76)

g. Base enclosure (see Base enclosure on page 80)
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Remove the display lid switch board:

1. Position the computer with the front toward you.

2. Disconnect the display lid switch board cable (1) from the LIF connector on the system board.

3. Detach the display lid switch board (2) from the clips built into the top cover.

4. Remove the display lid switch board and cable.

Reverse this procedure to install the display lid switch board and cable.
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System board

NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

For use only on HP EliteBook 8470w Mobile Workstation computer models:

For use only on computer models equipped with a graphics subsystem with discrete memory in all
countries and regions except the People's Republic of China and the Ukraine

686042-001

For use only on computer models equipped with a graphics subsystem with discrete memory in the
People's Republic of China and the Ukraine

691718-001

For use only on HP EliteBook 8470p Notebook PC computer models:

For use only on computer models equipped with a graphics subsystem with discrete memory in all
countries and regions except the People's Republic of China and the Ukraine

686041-001

For use only on computer models equipped with a graphics subsystem with discrete memory in the
People's Republic of China and the Ukraine

691717-001

For use only on computer models equipped with a graphics subsystem with UMA memory in all
countries and regions except the People's Republic of China and the Ukraine

686040-001

For use only on computer models equipped with a graphics subsystem with UMA memory in the
People's Republic of China and the Ukraine

691716-001

Before removing the system board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57), and then remove the following components:

a. Service cover (see Service cover on page 59)

b. Smart Card reader (see Smart Card reader on page 60)

c. Optical drive (see Optical drive on page 61)

d. Hard drive (see Hard drive on page 65)

e. Fan (see Fan on page 75)

f. Modem module (see Modem module on page 74)

g. Fan (see Fan on page 75)

h. Keyboard (see Keyboard on page 76)

i. Base enclosure (see Base enclosure on page 80)
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NOTE: When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

● SIM (see SIM on page 58, if applicable)

● Memory module (see Memory module on page 67)

● WWAN module (see WWAN module on page 69)

● WLAN module (see WLAN module on page 71)

● Heat sink (see Heat sink on page 100)

● Processor (see Processor on page 104)

Remove the system board:

1. Release the wireless antenna cables (1) from the routing clips (2) attached to the system board.

2. Disconnect the following cables from the system board:

(3) Display lid switch board cable

(4) Display panel cable

(5) Webcam/microphone module cable

(6) Fingerprint reader cable

(7) RTC battery cable
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3. Remove the three Phillips PM2.5×4.0 screws that secure the system board to the top cover.

4. Flex the right side of the top cover (1) until the connectors on the right side of the system board
are clear.

5. Lift the right side of the system board (2) until it rests at an angle.

6. Remove the system board (3) by sliding it up and to the right at an angle.

Reverse this procedure to install the system board.
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Heat sink

NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number

For use only on computer models equipped with a graphics subsystem with discrete memory 686021-001

For use only on computer models equipped with a graphics subsystem with UMA memory 693371-001

Before removing the heat sink, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57), and then remove the following components:

a. Service cover (see Service cover on page 59)

b. Hard drive (see Hard drive on page 65)

c. Optical drive (see Hard drive on page 65)

d. WLAN module (see WLAN module on page 71)

e. WWAN module (see WWAN module on page 69)

f. Fan (see Fan on page 75)

g. Keyboard (see Keyboard on page 76)

h. Base enclosure (see Base enclosure on page 80)

i. System board (see System board on page 97)

Remove the heat sink:

NOTE: Steps 1 and 2 apply to computer models equipped with a graphics subsystem with discrete
memory. See steps 3 and 4 for heat sink removal information for computer models equipped with a
graphics subsystem with UMA memory.

1. Following the 1, 2, 3, 4, 5, 6 sequence stamped into the heat sink, loosen the six captive Philllips
screws (1) and (2) that secure the heat sink to the system board.
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2. Remove the heat sink (3).

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
the system board components, it may be necessary to move the heat sink from side to side to
detach it.

NOTE: Steps 3 and 4 apply to computer models equipped with a graphics subsystem with UMA
memory. See steps 1 and 2 for heat sink removal information for computer models equipped with
a graphics subsystem with discrete memory.

3. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four captive Philllips
screws (1) that secure the heat sink to the system board.

4. Remove the heat sink (2).

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
the system board components, it may be necessary to move the heat sink from side to side to
detach it.
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NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
the system board components each time the heat sink is removed. Replacement thermal material is
included with the heat sink, processor, and system board spare part kits.

The following illustration shows the replacement thermal material locations on a computer model
equipped with a graphics subsystem with discrete memory.

● Thermal paste is used on the processor (1) and the heat sink section (2) that services it

● A thermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that
services it

The following illustration shows the replacement thermal material locations on a computer model
equipped with a graphics subsystem with UMA memory. Thermal paste is used on the
processor (1) and the heat sink section (2) that services it.
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Reverse this procedure to install the heat sink.
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Processor

NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

For use only on HP EliteBook 8470w Mobile Workstation computer models:

Intel Quad Core i7-3820QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB,
8.0-MB L3 cache, 45 W)

681284-001

For use on all computer models:

Intel Quad Core i7-3720QM 2.60-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB,
6.0-MB L3 cache, 45 W)

681283-001

Intel Quad Core i7-3610QM 2.30-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB,
6.0-MB L3 cache, 45 W)

680646-001

Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 4.0-
MB L3 cache, 35 W)

681954-001

Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

681953-001

Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

681952-001

For use only on HP EliteBook 8470p Notebook PC computer models:

Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

680645-001

Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 682417-001

Before removing the processor, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57), and then remove the following components:

a. Service cover (see Service cover on page 59)

b. Hard drive (see Hard drive on page 65)

c. Optical drive (see Hard drive on page 65)

d. WLAN module (see WLAN module on page 71)

e. WWAN module (see WWAN module on page 69)

f. Fan (see Fan on page 75)
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g. Keyboard (see Keyboard on page 76)

h. Base enclosure (see Base enclosure on page 80)

i. System board (see System board on page 97)

j. Heat sink (see System board on page 97)

Remove the processor:

1. Use a flat-bladed screw driver (1) to turn the processor locking screw one-half turn
counterclockwise, until you hear a click.

2. Lift the processor (2) straight up, and remove it.

NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon (4)
embossed on the processor socket when you install the processor.

Reverse this procedure to install the processor.
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ExpressCard assembly

Description Spare part number

ExpressCard assembly 684345-001

Before removing the ExpressCard assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57), and then remove the following components:

a. Service cover (see Service cover on page 59)

b. Hard drive (see Hard drive on page 65)

c. Optical drive (see Hard drive on page 65)

d. WLAN module (see WLAN module on page 71)

e. WWAN module (see WWAN module on page 69)

f. Fan (see Fan on page 75)

g. Keyboard (see Keyboard on page 76)

h. Base enclosure (see Base enclosure on page 80)

i. System board (see System board on page 97)

Remove the ExpressCard assembly:

1. Release the ZIF connector (1) to which the ExpressCard assembly cable is attached, and then
disconnect the ExpressCard assembly cable from the TouchPad board.

2. Release the ZIF connector (2) to which the TouchPad cable is attached, and then disconnect the
TouchPad cable from the ExpressCard assembly.
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3. Release the ExpressCard assembly cable from the clips (3) built into the top cover.

4. Remove the Phillips PM2.0×4.0 screw (1) that secures the ExpressCard assembly to the top cover.

5. Remove the ExpressCard assembly (2).

Reverse this procedure to install the ExpressCard assembly.
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Display assembly

NOTE: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.

Before removing the display assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 57), and then remove the following components:

a. Service cover (see Service cover on page 59)

b. Hard drive (see Hard drive on page 65)

c. Optical drive (see Hard drive on page 65)

d. WLAN module (see WLAN module on page 71)

e. WWAN module (see WWAN module on page 69)

f. Fan (see Fan on page 75)

g. Keyboard (see Keyboard on page 76)

h. Base enclosure (see Base enclosure on page 80)

Remove the display assembly:

1. Disconnect the display panel cable (1) and the webcam/microphone module cable (2) from the
system board.
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2. Release the display panel cable and the webcam/microphone module cable from the routing
channel (3) attached to the system board.

3. Release the wireless antenna cables (1) from the routing channel (2) attached to the
system board.

4. Remove the two Phillips PM2.5×4.5 screws (1) that secure the display assembly to the top cover.

5. Swing the display hinges (2) back until the top cover is free for removal.

6. Press the display release latch (3) to release the display assembly from the top cover.
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7. Remove the computer (4) from the display assembly.

8. If it is necessary to replace the display bezel or any of the display assembly subcomponents:

a. Remove the rubber screw covers (1). The rubber screw covers are available in the Display
Rubber Kit, spare part number 642785-001.

b. Remove the two Phillips PM2.5×5.0 screws (2) that secure the display bezel to the
display assembly.

c. Flex the inside edges of the bottom edge (3), the left and right sides (4), and the
top edge (5) of the display bezel until the bezel disengages from the display enclosure.
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d. Remove the display bezel (6). The display bezel is available using spare part numbers
686014-001 (for use only on HP EliteBook 8470w Mobile Workstation computer models)
and 686012-001 (for use only on HP ProBook 8470p Notebook PC computer models).

9. If it is necessary to replace the display hinges:

a. Remove the four Phillips PM2.0×3.0 screws (1) that secure the display hinge assemblies to
the display enclosure.

b. Remove the display hinge assemblies (2) from the display enclosure.

c. Remove the display hinge outer cover (3).

d. Remove the display hinge and inner cover (4) from the display enclosure.

e. Remove the display hinge outer cover (5) from the hinge.
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f. Remove the two Phillips PM2.0×3.0 screws (1) that secure the display hinge tube to the
display enclosure.

g. Release the display hinge tube (2) by sliding it away from the display enclosure.

h. Release the wireless antenna cables (3), display panel cable (4), and webcam/microphone
cable (5) from the display hinge tube, noting of the locations of the display cable guides (6)
at the left and right ends of the display hinge tube.

i. Remove the display hinge tube. The display hinge tube, display hinge inner covers, display
hinge outer covers, and display cable guides are available in the Display Hinge Cover Kit,
spare part number 686024-001.

The display hinges are available using spare part number 642782-001.

10. If it is necessary to replace the display panel:

a. Remove the four Phillips PM2.0×4.0 screws (1) that secure the display panel to the
display enclosure.

b. Remove the display panel (2) from the display enclosure. The display panel is available
using the following spare part numbers.

● 686047-001 — 14.0-in, LED, FLT, HD+, AntiGlare display panel

● 686046-001 — 14.0-in, LED, FLT, HD, AntiGlare display panel

● 684348-001 — 14.0-in, LED, SVA, HD+, AntiGlare display panel

● 684347-001 — 14.0-in, LED, SVA, HD, AntiGlare display panel

112 Chapter 4   Removal and replacement procedures



11. If it is necessary to replace the display panel cable:

a. Turn the display panel upside down, with the display panel cable toward you.

b. Detach the display panel cable (1) from the display panel rear surface.

c. Release the adhesive support strip (2) that secures the display panel cable to the
display panel.

d. Disconnect the display panel cable (3) from the display panel.

e. Remove the display panel cable. The display panel cable is included in the Display Panel Kit,
spare part numbers:

● 686019-001 — For use only on HP EliteBook 8470w Mobile Workstation computer
models equipped with an HD+ display assembly

● 686017-001 — For use only on HP EliteBook 8470w Mobile Workstation computer
models equipped with an HD display assembly
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● 686018-001 — For use only on HP EliteBook 8470p Notebook PC computer models
equipped with an HD+ display assembly

● 686016-001 — For use only on HP EliteBook 8470p Notebook PC computer models
equipped with an HD display assembly

12. If it is necessary to replace the webcam/microphone module and cable:

a. Release the shielding tabs (1) that secure the webcam/microphone module to the
display enclosure.

b. Detach the webcam/microphone module (2) from the display enclosure. (The webcam/
microphone module is attached to the display enclosure with double-sided tape.)

c. Disconnect the webcam/microphone module cable (3) from the webcam/
microphone module.

CAUTION: Handle the webcam/microphone module with caution. The module has a thin
profile and is susceptible to damage when not handled carefully.

d. Detach the webcam/microphone module cable from the contact points (4) on the
display enclosure.

e. Remove webcam/microphone module cable (5). The webcam/microphone module is
available using spare part number 686045-001. The microphone module is available using
spare part number 642798-001.

13. If it is necessary to replace the WLAN antenna cables and transceivers:

a. Release the WLAN antenna cables from the clips (1) and routing channel built into the
display enclosure.

b. Detach the WLAN antenna transceivers (2) from the display enclosure. (The WLAN antenna
transceivers are attached to the display enclosure with double-sided tape.)
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c. Remove the WLAN antenna cables and transceivers (3). The WLAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 685993-001.

14. If it is necessary to replace the WWAN antenna cables and transceivers:

a. Release the WWAN antenna cables from the clips (1) and routing channel built into the
display enclosure.

b. Detach the WWAN antenna transceivers (2) from the display enclosure. (The WWAN
antenna transceivers are attached to the display enclosure with double-sided tape.)

c. Remove the WWAN antenna cables and transceivers (3). The WWAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 685993-001.

Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup (BIOS) and
Advanced System Diagnostics

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.
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Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.

Updating the BIOS
Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
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NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your Web browser. For U.S. support, go to http://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.

6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics
Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. 1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Width 33.80 cm 13.31 in

Depth 23.13 cm 9.11 in

Height (front to back) 3.18 to 3.38 cm 1.25 to 1.33 in

Weight

HP EliteBook 8470w Mobile Workstation:

Equipped with 9-cell battery, optical drive, one memory
module, WLAN module, and solid-state drive

2.25 kg 4.96 lbs

Equipped with 9-cell battery, one memory module, WLAN
module, and solid-state drive

2.39 kg 5.27 lbs

Equipped with 6-cell battery, optical drive, one memory
module, WLAN module, and solid-state drive

2.41 kg 5.31 lbs

Equipped with 6-cell battery, one memory module, WLAN
module, and solid-state drive

2.55 kg 5.62 lbs

HP EliteBook 8470w Mobile Workstation:

Equipped with 9-cell battery, optical drive, graphics
subsystem with UMA memory, one memory module,
WLAN module, and solid-state drive

2.51 kg 5.53 lbs

Equipped with 9-cell battery, graphics subsystem with
UMA memory, one memory module, WLAN module, and
solid-state drive

2.37 kg 5.23 lbs

Equipped with 6-cell battery, optical drive, graphics
subsystem with UMA memory, one memory module,
WLAN module, and solid-state drive

2.35 kg 5.18 lbs

Equipped with 6-cell battery, graphics subsystem with
UMA memory, one memory module, WLAN module, and
solid-state drive

2.21 kg 4.87 lbs
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 Metric U.S.

Equipped with 3-cell battery, optical drive, graphics
subsystem with UMA memory, one memory module,
WLAN module, and solid-state drive

2.21 kg 4.87 lbs

Equipped with 3-cell battery, graphics subsystem with
UMA memory, one memory module, WLAN module, and
solid-state drive

2.07 kg 4.56 lbs

Input power

Operating voltage and current 18.5 V dc @ 3.5 A - 65 W

– or –

19.0 V dc @ 4.74 A - 90 W

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.

122 Chapter 6   Specifications



14.0-inch WGA display specifications

 Metric U.S.

Dimensions

Height 17.6 cm 6.93 in

Width 31.2 cm 12.28 in

Diagonal 35.7 cm 14.06 in

Number of colors up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format HD+, WVA (1600 x 1900)

HD, SVA (1366 x 768)

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 3.46 W

Viewing angle ±65° horizontal, ±50° vertical (typical)
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Hard drive specifications

 750-GB* 500-GB* 320-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Length 100.2 mm 100.4 mm 100.4 mm

Width 69.9 mm 69.9 mm 69.9 mm

Weight 110 g 110 g 110 g

Interface type SATA SATA SATA

Transfer rate

Synchronous (maximum) 1.1 GB/sec 1.1 GB/sec 1.1 GB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 2.0 ms 1.5 ms 1.5 ms

Average (read/write) 12/16 ms 11/13 ms 11/13 ms

Maximum 22 ms 22 ms 22 ms

Logical blocks 1,465,149,168 976,773,168 628,142,448

Disk rotational speed 7200 rpm 7200 rpm 7200 rpm

Operating temperature 0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

Recovery after a system failure is as good as your most recent backup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.
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Performing a recovery
Recovery allows you to repair or restore the computer to its original factory state. You can create an HP
factory image restore DVD, using an installed or an external DVD±RW optical drive. You can also
restore the computer to its factory condition from the HP dedicated recovery partition on the hard drive.

CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. All
files you have created and any software installed on the computer are permanently removed. The
recovery tool reinstalls the original operating system and HP programs and drivers that were installed at
the factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal
files must be restored from a backup.

To restore the computer using the HP factory image restore DVD, you must first create the recovery disc.
To create the recovery disc:

NOTE: HP recommends that you create the HP factory image restore DVD in the event of a
system failure.

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image Restore DVD in the
right pane.

3. Follow the on-screen instructions to create an image file to burn a recovery disc.

To restore the computer from the partition, follow these steps:

1. If possible, back up all personal files.

2. Insert the HP Factory Image Restore DVD into the external optical drive and restart the computer.

3. As the computer is restarting, press f9 to open the Computer Setup boot option menu.

4. Select the Notebook Upgrade Bay option.

5. Press the down arrow to select Restore SLED HP-BNB preload image from the Linux boot
menu, and then press enter.

6. Using the arrow keys, select Yes when prompted: Do you want to start the System-Restore?

7. Follow the on-screen instructions.

NOTE: You can also restore the computer from the partition by restarting the computer, and then
pressing the f11 key.

NOTE: If you are unable to boot (start up) your computer from the hard drive partition with the
primary operating system or from the recovery partition, and you did not create a system recovery disc,
you must purchase a SUSE Linux Enterprise Desktop Operating System DVD to reinstall the operating
system. For additional information, see the Worldwide Telephone Numbers booklet.
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Backing up your information
You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up
your system at the following times:

● At regularly scheduled times

● Before the computer is repaired or restored

● Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and then
click the Backup my home directory button.

2. Click Storage Destination Location, and then select a location to back up your information.

3. Click Schedule, and then select a time schedule to perform backups at a regularly
scheduled time.

To immediately back up your information, click the Backup Now check box.

NOTE: Before you back up your information, be sure you have designated a location to save
the backup files.

4. Click the Save and Backup button to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.

2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.

4. To restore all files from the selected location, click the Restore all files button. To restore
selective files only, click the Restore selected files button, and then click the Select Files
button and select the files to be restored.

5. Under Restore Point, click the time and date of the backup.

NOTE: If multiple backups have been performed, click the Use the latest version button to
restore the latest version.

6. Click the Restore button to start restoring the files, or click the Cancel button to cancel
the operation.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.

130 Chapter 9   Recycling

http://www.hp.com/recycle


Index

Symbols/Numerics
1394 port 20

A
AC adapter, spare part numbers

40, 49
AC adapter/battery light 19
accessory battery connector 23
antenna

locations 12
removal 114, 115
spare part number 35, 43,

115
Antenna Kit, spare part number

35, 43, 115
audio, product description 5
audio-in jack 21
audio-out jack 21

B
base enclosure

removal 80
spare part number 33, 44, 80

battery
removal 57
spare part numbers 32, 41,

42, 57
battery bay 23
battery release latch 23
battery release latch assembly

removal 89
spare part number 89

Blu-ray R/RE DVD±RW SuperMulti
DL Drive

precautions 51
removal 61
spare part number 32, 38,

45, 61

Blu-ray ROM DVD±RW SuperMulti
DL Drive

precautions 51
removal 61
spare part numbers 32, 38,

48, 61
Bluetooth compartment, location

24
Bluetooth module

removal 73
spare part number 32, 42, 73

Bluetooth module cable,
illustrated 36

bottom components 23
button components 14
buttons

keyboard light 13
optical drive eject 20
pointing stick 18
power 14
TouchPad 18
TouchPad on/off 14, 18
volume mute 15
Web browser 15
wireless 14

C
Cable Kit

components 36
spare part number 36, 42

cables, service considerations 50
caps lock light 17
carrying case, spare part

numbers 40, 41
chipset, product description 2
components

bottom 23
buttons 14
display 12

fingerprint reader 14
front 19
keys 15
left-side 20
lights 17
Rear 22
right-side 21
TouchPad 18

computer feet
location 56
spare part number 56

computer major components 27
computer part number 55
computer specifications 121
connectors, service

considerations 50

D
display

components 12
specifications 123

display assembly
removal 108
subcomponents 34

display bezel
removal 110
spare part numbers 34, 44,

111
Display Cable Kit, spare part

numbers 35
display enclosure, spare part

numbers 35, 43
display hinge

removal 111
spare part number 35, 42,

112
display hinge cover

removal 111
spare part number 44, 112

Index 131



Display Hinge Cover Kit, spare part
number 35, 112

Display Hinge Kit, spare part
number 35, 42, 44, 112

display lid switch board
removal 95
spare part number 30, 43, 95

Display Miscellaneous Kit, spare
part number 49

display panel
product description 3
removal 112
spare part numbers 35, 43,

44, 112
display panel cable

removal 113
spare part numbers 35, 44,

113
Display Panel Kit, spare part

numbers 113
Display Panel Support Kit, spare

part numbers 35, 44
display release latch 19
Display Rubber Kit, spare part

number 35, 42
display switch, location 12
DisplayPort 21
docking connector, location 23
drives, preventing damage 51
DVD-ROM Drive

precautions 51
removal 61
spare part numbers 32, 38,

48, 61
DVD±RW Double-Layer with

SuperMulti Drive
precautions 51
removal 61
spare part numbers 32, 38,

48, 61

E
electrostatic discharge 51
equipment guidelines 54
eSATA port 21
Ethernet, product description 6
ExpressCard assembly

removal 106
spare part number 30, 43,

106

ExpressCard slot 20
ExpressCard slot space saver,

illustrated 39
external monitor jack 22

F
fan

removal 75
spare part number 31, 42, 75

feet
location 56
spare part number 56

fingerprint reader 15
fingerprint reader board

removal 92
spare part number 30, 43, 92

fingerprint reader component 14
flash cache module, spare part

number 48
flash cache, product description 3
fn key 15
front component 19
function keys 15

G
graphics, product description 2
grounding guidelines 51
guidelines

equipment 54
grounding 51
packaging 53
transporting 53
workstation 53

H
hard drive

precautions 51
product description 4
removal 65
spare part numbers 32, 37,

42, 43, 65
specifications 124

hard drive bracket
illustrated 37
removal 66

Hard Drive Hardware Kit
spare part number 32, 37,

42, 65
hard drive light 19
headphone jack 21

heat sink
removal 100
spare part numbers 32, 44,

49, 100

J
jacks

audio-in 21
audio-out 21
external monitor 22
headphone 21
microphone 21
modem 22
monitor 22
network 22
RJ-11 22
RJ-45 22

K
key components 15
keyboard

product description 8
remval 76
spare part numbers 28, 29,

45, 46, 47, 48, 76
keyboard light 13
keyboard light button 13
keys

fn 15
function 15
num lk 16
perating system applications

15
perating system logo 15

L
Latch Kit, spare part number 33,

43, 86, 89
left-side components 20
light components 17
lights

AC adapter/battery 19
caps lock 17
hard drive 19
keyboard 13
mute 17
num lock 17
power 17, 19
TouchPad 17
Web browser 17

132 Index



webcam 12
wireless 17, 19

lock, spare part numbers 40, 41

M
mass storage device

illustrated 37
precautions 51
spare part numbers 37

Media Card Reader, location 20
memory module

product description 3
removal 67
spare part numbers 42, 43,

67
microphone

location 12
product description 5

microphone jack 21
microphone module

removal 114
spare part number 35, 42,

114
model description 56
model name 1
modem jack 22
modem module

removal 74
spare part number 31, 42, 74

modem, product description 6
monitor jack 22
mouse, spare part numbers 40,

41
mute light 17

N
network jack 22
num lk key 16
num lock light, location 17
numeric keypad 16

O
operating system applications

keys 15
operating system logo keys 15
operating system, product

description 9
optical drive

precautions 51
product description 5

removal 61
spare part numbers 32, 38,

45, 48, 61
optical drive bay space saver,

illustrated 39
optical drive eject button 20

P
packaging guidelines 53
plastic parts, service

considerations 50
Plastics Kit

contents 39
spare part numbers 39, 44,

48
pointing device, product

description 8
pointing stick 18
pointing stick button 18
ports

1394 20
DisplayPort 21
eSATA 21
product description 8
USB 20, 21

power button 14
power connector 20
power cord

set requirements 128
spare part numbers 40, 41

power light 17, 19
power requirements, product

description 8
processor

product description 1
removal 104
spare part numbers 31, 43,

104
product description

audio 5
chipset 2
display panel 3
Ethernet 6
external media cards 7
flash cache 3
graphics 2
hard drive 4
keyboard 8
memory module 3
microphone 5

modem 6
operating system 9
optical drive 5
pointing device 8
ports 8
power requirements 8
processors 1
product name 1
security 9
serviceability 11
solid-state drive 4
upgrade bay drive 4
video 5
wireless 6

product name 1, 55
product number 55

R
rear components 22
removal/replacement

preliminaries 50
procedures 55

right-side components 21
RJ-11 jack 22
RJ-11 jack cable

illustrated 36
removal 85

RJ-11 jack plug, illustrated 39
RJ-45 jack 22
RTC battery

removal 94
spare part number 30, 42, 94

Rubber Kit, spare part number
33, 42

S
Screw Kit, spare part number 41,

44
security cable slot 22
security, product description 9
serial number 55
service considerations

cables 50
connectors 50
plastic parts 50

service cover
location 24
removal 59
spare part number 33, 44, 59

service cover release latch 23

Index 133



service cover release latch
assembly

removal 86
spare part number 86

service tag 25, 55
serviceability, product description

11
SIM, removal 58
Smart Card reader 20, 21

removal 60
spare part number 30, 44, 60

solid-state drive
precautions 51
product description 4
spare part numbers 38, 48,

49
speaker assembly

removal 83
spare part number 32, 42, 83

speakers 19
specifications

computer 121
display 123
hard drive 124

system board
removal 97
spare part numbers 30, 44,

48, 49, 97

T
tools required 50
top cover, spare part numbers

30, 44, 48
TouchPad board cable, illustrated

36
TouchPad button 18
TouchPad components 18
TouchPad light 17
TouchPad on/off button 14, 18
TouchPad zone 18
transporting guidelines 53

U
upgrade bay cradle

removal 63
spare part number 38, 42,

63
upgrade bay drive, product

description 4
upgrade bay, location 20

USB port 20, 21

V
vents 22, 23
video, product description 5
volume mute button 15

W
warranty period 56
Web browser button 15
Web browser light 17
webcam 12
webcam light 12
webcam/microphone module

removal 114
spare part number 34, 44

wireless antenna
locations 12
removal 114, 115
spare part number 35, 43,

115
Wireless Antenna Kit, spare part

number 115
wireless button 14
wireless light 17, 19
wireless module compartment 23
wireless, product description 6
WLAN module

removal 71
spare part numbers 31, 41,

42, 43, 71
workstation guidelines 53
WWAN module

removal 69
spare part numbers 31, 42,

43, 69

134 Index




	Product description
	External component identification
	Display
	Buttons and fingerprint reader (select models only)
	Keys
	Lights
	TouchPad
	Front
	Left side
	Right side
	Rear
	Bottom

	Illustrated parts catalog
	Service tag
	Computer major components
	Display assembly subcomponents
	Cable Kit
	Mass storage devices
	Plastics Kit
	Miscellaneous parts
	Sequential part number listing

	Removal and replacement procedures
	Preliminary replacement requirements
	Tools required
	Service considerations
	Plastic parts
	Cables and connectors
	Drive handling

	Grounding guidelines
	Electrostatic discharge damage
	Packaging and transporting guidelines
	Workstation guidelines
	Equipment guidelines





	Component replacement procedures
	Service tag
	Computer feet
	Battery
	SIM
	Service cover
	Smart Card reader
	Optical drive
	Upgrade bay cradle
	Hard drive
	Memory module
	WWAN module
	WLAN module
	Bluetooth module
	Modem module
	Fan
	Keyboard
	Base enclosure
	Speaker assembly
	RJ-11 jack cable
	Service cover release latch assembly
	Battery release latch assembly
	Fingerprint reader board
	RTC battery
	Display lid switch board
	System board
	Heat sink
	Processor
	ExpressCard assembly
	Display assembly


	Computer Setup (BIOS) and Advanced System Diagnostics
	Starting Computer Setup
	Using Computer Setup
	Navigating and selecting in Computer Setup
	Restoring factory settings in Computer Setup

	Updating the BIOS
	Determining the BIOS version
	Downloading a BIOS update

	Using Advanced System Diagnostics

	Specifications
	Computer specifications
	14.0-inch WGA display specifications
	Hard drive specifications

	Backup and recovery
	Performing a recovery
	Backing up your information

	Power cord set requirements
	Requirements for all countries
	Requirements for specific countries and regions

	Recycling
	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile ()
  /CalRGBProfile (ColorMatch RGB)
  /CalCMYKProfile (U.S. Sheetfed Uncoated v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.3
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket true
  /DefaultRenderingIntent /Default
  /DetectBlends false
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 524288
  /LockDistillerParams true
  /MaxSubsetPct 100
  /Optimize false
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts false
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile (None)
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 2400
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check true
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError false
  /PDFXTrimBoxToMediaBoxOffset [
    36.00000
    36.00000
    36.00000
    36.00000
  ]
  /PDFXSetBleedBoxToMediaBox false
  /PDFXBleedBoxToTrimBoxOffset [
    14.40000
    14.40000
    14.40000
    14.40000
  ]
  /PDFXOutputIntentProfile (GWG_GenericCMYK)
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /SyntheticBoldness 1.000000
  /CheckCompliance [
    /PDFX3:2002
  ]
  /Description <<
    /ENU <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [14172.000 14172.000]
>> setpagedevice


